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TwinCAT – bližnjice za lažje delo

Tools → Customize → Commands → Keyboard...

Infosys

https://infosys.beckhoff.com/content/1033/tc3_userinterface/2526086283.html?id=6999346871273813293


Funkcijski načrt: standard

• Funkcijski načrt je eden od standardnih grafičnih jezikov

• Nazorno prikazuje medsebojno povezanost funkcij in funkcijskih 
blokov

• Podobni so električnim in blokovnim shemam iz analogne in 
digitalne tehnike

• Vsak blok ima vhode in izhode
• Povezave nakazujejo tok električnega toka v pravih vezjih

• Bloki običajno predstavljajo kombinatorične funkcije (odločitvena 
vezja), lahko pa imajo tudi spomin (sekvenčna vezja).

• Standard dovoljuje tudi povratne povezave
• Predpisuje definiranje vrstnega reda izvajanja povratno povezanih blokov, 

ne pa načina



Funkcijski načrt: standard

Funkcijski blok je definiran z
• vmesnikom

• število in tipi vhodov
in izhodov

• funkcionalnostjo črne škatle 
(ang. black box)
• delovanje bloka je opisano 

grafično, tabelarično, s formulo, opisno

Pravila povezovanja
• Vsak signal je povezan z natanko enim virom
• Vir, ponor in povezava morajo biti istega podatkovnega tipa

PIDreferenca

meritev motor

parameteri

Primer:

signal_b

signal_c

signal_a

Primer:



Funkcijski načrt: program

Izvajanje programa
• od zgoraj navzdol
• od leve proti desni
• izjema so povratne 

povezave

Primer
• Razvojno okolje podjetja 

ABB



Funkcijski načrt: program

Primer:
Vodenje motorja v 
Siemens TIA Portal



Funkcijski načrt: program

Dekompozicija problema
• Elementarni blok

• Mikrokoda, zbirnik, ST, …

• Sestavljeni blok
• Povezuje več elementarnih blokov v celoto

• Funkcijski načrt

=



Funkcijski načrt: program

Segmentacija
• Zaradi večje preglednosti funkcijski 

načrt razdelimo v več segmentov

• Znotraj segmenta so povezave 
predstavljene grafično

• Segmente med seboj povezujejo 
spremenljivke (začasne)

Segment A

Segment B

X1

M2 M1

Y1

Y2

M2

X2

M1

X3



Funkcijski načrt: TwinCAT

Koncept klinov (network) prevzet iz lestvičnih 
diagramov

• program se izvaja sekvenčno, klin za klinom, od 
leve proti desni

Dobra praksa:
• Vsi vhodi naj bodo definirani, da ne pride do 

neželenega obnašanja.
• Vsak izhod (%Q) naj se v programu pojavi samo na 

enem mestu.

Primer: osnovne operacije
• negacijo dobimo preko 

kontekstnega menija 
(desni klik)

Preklop LD → FBD
• Extensions → FBD/LD/IL→ View



Diagram poteka: standard

SFC (Sequential Function Chart)
• Opisuje zaporedje operacij in interakcij med 

vzporednimi procesi

• Matematični temelji so v Petrijevih mrežah

• Stanja so povezana s prehodi

Žeton
• Stanje je aktivno ob prisotnosti žetona

• Žeton zapusti stanje, ko je izpolnjen pogoj 
za prehod

• Samo en prehod se lahko zgodi naenkrat

• Žeton je ob začetku programa v začetnih 
stanjih

Ec = ((varX & varY) | varZ)   

žeton

Sa

Sb

"1"

Ea

Sc

Eb

prehodi

stanja pogoj za prehod

primer: stanje Sc je aktivno, 

S0, Sa, Sb niso aktivna

S0



Diagram poteka: standard

Izvajanje programa
• Žeton prečka prvi aktivni prehod

• V primeru, da sta Ea in Eb oba izpolnjena
se upošteva nastavljene prioritete ali 
naključje

• Ko je pogoj Ee izpolnjen, se žeton razdeli 
na obe povezani stanji

• Ko so prisotni vsi razdeljeni žetoni in 
je pogoj Ef izpolnjen, pot nadaljuje en 
sam žeton

Eb

Sa

Sb

"1"

Ea

Se

Ec

Ed

Ee

Sc

Sd

Sf Sg

Ef



Diagram poteka: program

Nevarnosti zapletenih diagramov
• Smrtni objem (deadlock)

• Nekontrolirano delo z žetoni

Rešitev
• Omejitve urejevalnika

• Funkcije urejevalnika



Diagram poteka: program

Zapis diagrama v preglednejšo, strukturirano obliko
• Uporabimo podvajanje stanj

Delo z izjemnimi dogodki
• Zaklepanje stanja (interlock)

• Ob podanem pogoju se akcije v stanju prekinejo
• Prehod v novo stanje je mogoč

• Nadzorne napake
• Ko pride do napake, prehod v naslednje stanje ni mogoč
• Avtomat se ustavi

A

B

C

a

b

d

c

A

B

C

a

b

a

b
B'

A'

d

c

d



Funkcijski načrt
• Zvezno vodenje, regulacija

Diagram poteka
• Koračno/sekvenčno vodenje, 

krmiljenje

Diagram poteka: primerjava

Velikokrat je najboljša izbira kombinacija obeh, 
zato mora biti komunikacija med njimi mogoča:

združevanje na nivoju funkcijskih blokov.



Primer
• Funkcijski načrt • Diagram poteka

Diagram poteka: primerjava

a

b c

dNOT

S

R

c

d

"1"

b

a



Diagram poteka: primerjava

S

R

≥

&

S

R

&

S

R

&

init

a

b

c

A

B

C

A

B

C

"1"

a

b

c

Primer
• Funkcijski načrt • Diagram poteka



Diagram poteka: primer Siemens Graph



Diagram poteka: TwinCAT

SFC lahko uporabimo le v programu ali 
funkcijskemu bloku, v funkciji ne.

Pogoji za prehode (transition) so lahko napisani 

v poljubnem jeziku IEC in vključeni kot klici ali 

pa so zapisani neposredno (inline) v jeziku ST.

Stanja
• Izvajajo akcije

• ko je stanje aktivno
• po standardu IEC – action association

• razširitev standarda – step main action

• ob vstopu (razširitev – step entry action)
• ob izstopu (razširitev – step exit action)

Infosys

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2530346123.html?id=5313919943789402891
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2528430219.html?id=4865653214793657869
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2526785419.html?id=4069371448104899987


Diagram poteka: Kvalifikatorji akcije v stanju (IEC)

Kvalifikator Ang. Pomen

N non-stored Akcija je aktivna, dokler je stanje aktivno.

R0 overriding reset Akcija je resetirana, torej deaktivirana.

S0 set / stored Akcija je izvedena takoj, ko stanje postane aktivno in nadaljuje z 
izvajanjem tudi, ko stanje ni več aktivno – dokler akcija ni resetirana.

L time limited Akcija se začne izvajati takoj, ko je stanje aktivno in se izvaja ves čas
aktivnosti stanja oziroma do poteka časovnika.

D time delayed Akcija se začne izvajati, ko preteče časovnik ob vstopu v stanje in je stanje
še vedno aktivno. Izvaja se dokler je stanje aktivno.

P pulse Akcija je izvedena natanko dvakrat: ko stanje postane aktivno in 
v sledečem programskem ciklu.

SD stored and time delayed Akcija se začne izvajati, ko preteče časovnik ob vstopu v stanje in se 
izvaja, dokler akcije ne resetiramo.

DS delayed and stored Akcija se začne izvajati, ko preteče časovnik ob vstopu v stanje in je stanje
še vedno aktivno. Izvaja se, dokler akcije ne resetiramo.

SL stored and time limited Akcija se začne izvajati takoj, ko je stanje aktivno in se izvaja do poteka
časovnika ali do reseta.

Infosys

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2528356235.html?id=2008640879008199007


Lista ukazov: standard

Nizkonivojski programski jezik
• Podoben zbirniku
• Neprijazen do uporabnika

• Koda ni strukturirana
• Šibka semantika
• Odvisen od programirljivega krmilnika

• Leta 2012 je v 3. izdaji standarda IEC 61131-3 postal zastarel (argument komisije: zbirni jezik 
ni več primeren za razvoj v modernih razvojnih okoljih).

Večinsko mnenje
• Osnovni jezik, ki naj bi ga podpirali programirljivi logični krmilniki, ki so združljivi z IEC
• Standard osnovnega jezika ne definira

Namenjen izkušenim programerjem za
• Izdelavo časovno in prostorsko učinkovite programske kode
• V ta jezik naj bi se prevedli vsi višjenivojski programski jeziki (tega standard ne zahteva)



Lista ukazov: standard

Vsak ukaz se začne v novi vrstici, ki vsebuje:
• Oznako na začetku vrstice, ki se zaključi se z dvopičjem

• Operacijsko kodo (operator / mnemonik)

• Operande, ločene z vejicami

• Komentar na koncu vrstice

Dovoljene so prazne vrstice ali vrstice samo z oklepaji.



Lista ukazov: standard

Osnovni ukazi
• 21 ukazov

• Rezultati operacij se
shranjujejo v register RLO 
(Result of Logic Operation)

• modifikator
• N – negacija rezultata

• C – pogojna izvedba

• ( – zakasnitev rezultata

Nr. Operator Modifier Operand Definition

1 LD N Note 1 Sets the actual result of the operand

2 ST N Note 1 Stores the actual result in the operand

address

3 S

R

Note 2

Note 2

BOOL

BOOL

Set Boolean operator to 1

Reset Boolean operator to 0 

4

5

6

7

AND

&

OR

XOR

N, (

N, (

N, (

N, (

BOOL

BOOL

BOOL

BOOL

Boolean AND

Boolean AND

Boolean OR

Boolean Exclusive-OR

8

9

10

11

ADD

SUB

MUL

DIV

(

(

(

(

Note 1

Note 1

Note. 1

Note 1

Addition

Subtraction

Multiplication

Division

12

13

14

15

16

17

GT

GE

EQ

NE

LE

LT

(

(

(

(

(

(

Note 1

Note 1

Note 1

Note 1

Note 1

Note 1

Comparison: >

Comparison: >=

Comparison: =

Comparison: <>

Comparison: <=

Comparison: <

18

19

20

JMP

CAL

RET

C,N

C,N

C,N

MARK

NAME

Jump to the Mark

Call function block (Note 3)

Return to a function or a function block

21 ) Processing reset operations

Note 1: The operations must be either loaded or given with a type. 

The actual result and the operand must have the same type. 

Note 2: The operations are only executed when the value of the actual result is a Boolean 1. 

Note 3: A list of arguments in parenthesis follow the name of the function block



Lista ukazov: standard

Primeri
AND %IX1 (* Rezultat := Rezultat AND %IX1 *)

AND( %IX1
ORN %IX2
) (* Rezultat := Rezultat AND (%IX1 OR NOT %IX2) *)

LD 15
ST C10.PV
LD %IX10
ST C10.CU
CAL C10 (* Klic funkcije: CAL C10(CU:=%IX10, PV:=15) *)



Lista ukazov: TwinCAT

Programski jezik IL moramo omogočiti v nastavitvah:
Tools → Options → TwinCAT → PLC Environment → FBD, LD and IL → IL

Če želimo prikazati komentarje vsake vrstice liste ukazov, to storimo v 
zavihku General → Show operand comment



Lista ukazov: TwinCAT

Koncept klinov (network) prevzet iz lestvičnih diagramov.

Primer: funkcijski blok, ki opravlja osnovne logične operacije. FB nato kličemo iz programa.



Strukturirano besedilo: standard

• Jezik podoben Pascalu

• Primeren za kompleksne obdelave 
podatkov

• Z izrazi določamo vrednosti na podlagi 
vrednosti spremenljivk in konstant

• Nujna je uporaba 
zahtevanih podatkovnih tipov
• Pretvarjanje med tipi s funkcijami
• Primer: REAL_TO_INT(..)

• Izraz je sestavljen iz operatorjev in 
operandov
• Izračunavanje po prioriteti
• V primeru enake prioritete od leve proti 
desni
• Primer: X := (A+B-C)*ABS(D);

Operacija Oznaka Prioriteta

1 Oklepaj (izraz) Visoka

2 Klic funkcije ImeF(argumenti)

LN(A), MAX(X,Y)

3 Potenciranje EXPT

4

5

Predznak

Negacija

-

NOT

6

7

8

Množenje

Deljenje

Modulo

*

/

MOD

9

10

Seštevanje

Odštevanje

+

-

11 Primerjava <, >, <=, >=

12

13

Enakost

Neenakost

=

<>

14 IN AND, AND_THEN

16 Ekskluzivni ALI XOR

17 ALI OR, OR_THEN Nizka

Infosys

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2528237963.html?id=8642866414100594287


Strukturirano besedilo: standard – stavki

Stavek Primer

Prireditev CV := CV + 1; 

C := SIN(X);

Klic in uporaba 

funkcijskega bloka

CMD_TIMER(IN := %IX5, 

PT := T#300ms);

A := CMD_TIMER.Q;

Izhod iz FB/FUN RETURN;

IF IF D < 0.0 THEN 

NROOTS := 0;

ELSIF D = 0.0 THEN

NROOTS := 1;

ELSE

NROOTS := 2;   

END_IF;

CASE TW := BCD_TO_INT(THUMBWHEEL);

CASE TW OF

1: DISPLAY := OVEN_TEMP;

2,3: DISPLAY := MOTOR_SPEED;

ELSE 

DISPLAY := 0;

END_CASE;

Stavek Primer

Zanka FOR J := 101;

FOR I := 1 TO 100 BY 2 DO

IF WORDS[I] = 'KEY' THEN

J := I;

EXIT;

END_IF;

END_FOR;   

Zanka WHILE J := 1;

WHILE J <= 100 DO

J := J + 2;

END_WHILE;

Zanka REPEAT J := -1;

REPEAT

J := J + 2;

UNTIL J = 101 

END_REPEAT;

EXIT EXIT;

Prazen stavek ;

Infosys

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2528221835.html?id=6103164662326938961


Strukturirano besedilo: primeri



Strukturirano besedilo: primeri

Funkcijski blok za krmiljenje 
motorja tipa premik-smer

• Blokada prehitre menjave 
smeri vrtenja

• Varčevanje z releji 
(specifika učnih modelov)



Tehnike programiranja: uvedba stanj

Razlogi
• Določeni deli programa se lahko izvajajo samo ob določenih pogojih
• Potreba po zaklepanju klinov oz. delov programske kode

Razdelitev programa na logična stanja
• Stanja in prehodi med njimi morajo biti jasno določeni tako v ročnem kot avtomatskem načinu

• Stanja določena glede na akcije izvršnih sistemov in vrednosti merilnih sistemov

• Lažje programiranje kompleksnih sistemov
• Lažji obratni inženiring

• Koda za vsako stanje enostavnejša
• Pogoji za prehajanje med stanji so veliko bolj očitni
• Vsak programer piše na svoj način

Prednosti
• Skrajšanje zagona sistema zaradi napak v programu za 85 %

• Predvsem na račun enostavnejših pogojev za zaklepanje klinov
• V tipičnem lestvičnem diagram je velik del kode namenjenih zaklepanju klinov

• 35 % pri procesni kontroli (zvezni procesi, regulacija)
• 60 % pri sekvenčnem procesu



Tehnike programiranja: uvedba stanj

Programiranje
• Posnemanje konceptov jezika diagram poteka (SFC)
• Ob izpolnjenem pogoju za prehod v novo stanje se:

• aktivira ustrezna spremenljivka (žeton) za novo stanje (nastavimo, set)
• deaktivira spremenljivka za trenutno stanje (brišemo, reset)

• Če je lahko hkrati aktivnih več stanj, je potrebno paziti, da se pri prehodu v novo skupno 
stanje deaktivirajo vsa trenutna stanja.

• Označevanje stanj
• Z biti: en bit ustreza enemu stanju (ang. one hot encoded)

• Številčno: uporaba celoštevilčne spremenljivke (in primerjalnika)

• Ob zagonu sistema je potrebna logika, ki zna
• ugotoviti, v katerem stanju se je sistem ustavil

• preskakovanje stanj in ne njihovo zaporedno izvajanje, ki je lahko zelo nevarno!

• postaviti sistem v začetno stanje ali
• preprečiti njegovo delovanje, če ni v pravem stanju, in to ustrezno alarmirati (najlažje)



Tehnike programiranja: spremljanje materiala

Izdelava sestavljenega podatkovnega tipa –
strukture (DUT, data unit type), ki predstavlja 
logično sliko enega obdelovanca / materiala

• Podatki o materialu: črtna koda (ID), fizične 
mere, neustreznost, …

• Ciljna lokacija
• Navodila za obdelavo (recept)
• Funkcije na trenutni lokaciji: zasedenost , 

premikanje, …

TwinCAT
• PLC → <Project> → DUTs → Add → DUT...
• Ustvarimo novo strukturo
• Pomagamo si lahko tudi s tabelami (ARRAY)

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2530071691.html?id=5804515246859108333
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2529481355.html?id=5034243832068230001
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2529464203.html?id=4209795632908374042


Tehnike programiranja: spremljanje materiala

Sekvenčni proces
• Vsaka fizična enota (mesto) ima tudi svojo logično sliko

• Vsaka enota na enkrat lahko izpolnjuje le eno nalogo
• Primer: trije tekoči trakovi

• Enostavna komunikacija:
zahteva, dovoljenje, akcija, potrditev, (alarm)

• Prepisovanje struktur
• Ob izpolnjenih pogojih se celotna slika prenese iz enega mesta na drugega

• Material je fizično na novem mestu

• Senzorska slika ustreza bodoči logični sliki (dvojna kontrola)

• Prepis naj NE bo vezan na fronto fotocelice

• Alarmiranje v primeru, da se logična in fizična shema po določenem času ne 
ujemata



Tehnike programiranja: organizacija programa

1. Branje senzorjev v strukture
Umerjanje senzorjev, skaliranje analognih vrednosti, pretvorbe (NC → NO)

2. Proženje alarmov

3. Upravljanje alarmov
Potrjevanje in ničenje alarmov

4. Priprava podatkov za vmesnike človek-stroj
Pretvorbe (NC → NO), izračuni, ločene podatkovne strukture (svoj FB) zaradi boljše preglednosti

5. Glavni program
Avtomat prehajanja stanj

6. Sledenje materiala
Glede na fizično sliko

7. Varnostne funkcije
• Varovanje človeka in opreme
• Zaradi varnosti neodvisne od glavnega programa
• Blokada prehitre menjave smeri vrtenja

8. Aktivacija izvršnih sistemov



Linija z dvema napravama in 

Pnevmatski sistem:

• Definicija lokacij, kjer je tipalo (fotocelica 

ali končno stikalo); "navidezne" lokacije 

(potiskač, vrtljiva miza, vhod na trak)

• Avtomat za vsako lokacijo ali izvršni člen

• Odvisnosti (predhodno, naslednje mesto)

• Vrtljiva miza (vodenje položaja, materiala 

na mizah)

• Spremljanje materiala

• črtna koda (ID)

• naloga/recept

• vnos vrednosti na prvi lokaciji preko IDE

Robot

• Hierarhija avtomatov:

• Avtomat za vsako os (vrtenje, dvig, 

izteg, prijem)

• Avtomat, ki povezuje vse štiri osi

• Pojdi na lokacijo

• Pojdi na lokacijo in poberi

• Pojdi na lokacijo in odloži

• Avtomat, ki izvaja "program" 

premikov

• Spremljanje materiala

• črtna koda (ID)

• lokacije/pozicije objektov

Tehnike programiranja: učni modeli
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